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EDITING A MOVIE 

 Creating Clips 

 You might want to create several smaller, more 

manageable clips from a single existing video clip to make 

it easier to work with your project. 
 

 Windows Movie Maker creates clips in different ways, 

depending on the clip's source. 
 

 If the source clip is from a digital video (DV) camera, 

Windows Movie Maker creates clips that are based on the 

time stamps that the DV camera inserts when the source 

video is originally recorded, as well as significant frame 

changes in the video. 
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EDITING A MOVIE 

 Adding Movie Titles, Caption and Credits 
 With Windows Live Movie Maker, you can add a title, 

your name, the date, credits, and other text to your 
movie. 
 For example, you might want to add a title to introduce a 

person or scene that appears in your movie. 
 

 You can add title text to various places in your movie: 
at the beginning or end, before or after a clip, or 
overlaying a clip. 
 

 The title plays for the specified amount of time, either 
on the screen by itself or overlaying the video as it 
plays (caption), and then the title disappears and the 
video clip or picture continues. 
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EDITING A MOVIE 

 Adding Movie Titles 
1. If you know where you want the title or credit to appear 

in your movie, click that location on the SB/TL 
(Storyboard/Timeline) Hybrid. 
 

2. Click Home, and then click Title. 
 

3. In the Enter text for title box, type the text that you want 
to appear as the title. 
 

4. After you type the text, the preview displays the default 
animation and format for the title you want to add. 
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EDITING A MOVIE 

 Adding Movie Titles 
 

5. To change the title animation, click an effect under the 
Effects section. 

 

6. To change the font and color for your title, click the 
options under the Paragraph and Font sections and 
set the appropriate options to modify the font, font 
color, formatting, background color, transparency, font 
size, and position of the title to your liking. 
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EDITING A MOVIE 

 Adding Movie Credits 
1. If you know where you want the title or credit to appear 

in your movie, click that location on the SB/TL 
(Storyboard/Timeline) Hybrid  (Typically at the end). 
 

2. Click Home, and then click the arrow next to Credits.  
This brings up a list 
 

3. Click the desired type of credits that you want. 
 

4. In the Enter text for title box, type the text that you want 
to appear as the credits. 
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EDITING A MOVIE 

 Adding Movie Titles 
 

5. After you type the text, the preview displays the default 
animation and format for the title you want to add 

 

6. To change the title animation, click an effect under the 
Effects section. 

 

7. To change the font and color for your title, click the 
options under the Paragraph and Font sections and 
set the appropriate options to modify the font, font 
color, formatting, background color, transparency, font 
size, and position of the title to your liking. 
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PRACTICE #1 

1. Add a title at the beginning of the movie and 
give it a meaningful name (e.g. Computers 
in Education) 
 

2. Add credits at the end of the movie.  The 
first line should say credits. 
 

3. Subsequent lines must include category for 
Video Editing and your name should be 
associated with it. 
 

4. The final line type “Thank you for watching”. 
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EDITING A MOVIE 

 Adding Transitions/Effects 
 A transition controls how your movie plays from 

one video clip or picture to the next. 
 

 You can add a transition between two pictures, 
video clips, or titles in any combination on the 
storyboard/timeline. 
 

 You might choose to use a popular and great-
looking transition like Cinematic. 
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EDITING A MOVIE 

 Adding Transitions/Effects 
 

 Or you might choose to use more brash 
transitions, such as, Split Vertical, or 
Diamond (to name just a few). 
 

 You can improve your moviemaking by adding 
your own special touches to make your movies 
look distinctive and professional. 
 

 By adding transitions and effects, you can 
make sure that your movie flows nicely from 
one scene to the next and give it the look you 
want. 
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EDITING A MOVIE 

 Adding Transitions 

 Follow these steps: 

1. On the SB/TL, click the second of the two video clips, 

titles, or pictures that you want to add a transition 

between. 
 

2. Click the Animations tab, and then click on a transition. 
 

3. You can click Play under the monitor to see a preview of 

what the transition looks like. 
 

4. Set the duration for the transition.  It has a preset time, 

but you can change it if you wish. 

5. If you have multiple video clips and you wish to use the 

same transition between clips, then click Apply to all. 
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PRACTICE #2 

 

1. Put a transition between all your clips.  

Experiment with several ones 
 

2. Re-save your project. 
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EDITING A MOVIE 
 Adding Effects 

 Effects enable you to add special effects to your 
movie. 

 For example, you might have an imported video that you want 
to look and feel like a classic, old-time movie. 
 

 If so, you could add one of the Film Age effects to a video clip, 
picture, or title to make the video for that clip look like an old-
time movie. 
 

 Follow these steps: 
1. On the SB/TL, select the video clip, picture, or title to which you 

want to add the effect. 
 

2. Click the Visual Effects tab. 
 

3. In the Effects group, click the effect you want to add. You can 
click Play under the preview monitor to see a preview of what 
the effect looks like. 
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PRACTICE #3 

1. Put a Cinematic-blur effect in your Title 

clip. 
 

2. For the next clip, select the Wipe Right 

Narrow  
 

3. Incorporate effects to your other clips 

accordingly. 
 

4. Re-save your project. 
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PRACTICE #4 

1. Using Audacity, create a brief narration for 

the title clip introducing yourself and stating 

the topic of the video.  No more than 30 

seconds. 
 

2. If the narration ends up to be longer than 

the duration of the title clip, adjust the latter 

accordingly. 
 

3. Re-save the project. 
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EDITING A MOVIE 
 Adding Music 

 Music can be an excellent way to establish the 
mood of your movie, and adding music is easy 
in Windows Movie Maker 
 

 Follow these steps: 
1. Select the approximate location of where you want 

the song. 
 

2. Click Home, and then click Add Music. 
 

3. Browse to the file that you want to add, and then 
click the file. 
 

4. Click Open. 
 

5. You can change the duration of the song to 
synchronize with the video.  
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PRACTICE #5 

1. Import Mystery.mp3 from Wikispaces into 

your project. 
 

2. Add it to the timeline.  It should start at the 

title clip.  Adjust accordingly. 
 

3. Re-save your project. 
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USING PICTURES FROM VIDEO FRAMES 

 You can take a picture of an individual frame from 
an imported video clip in Windows Movie Maker 
and then use that picture in your movie as a still 
picture. 
 

 Pictures that you take from video clips in 
Windows Movie Maker are automatically saved as 
JPEG files, with a .jpg file name extension. 
 

 Follow these steps: 
1. Click the video clip that you want to take a picture from. 
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USING PICTURES FROM VIDEO FRAMES 

2. Under the monitor, drag the playback indicator 
on the seek bar to the frame of the video that 
you want to capture as a picture. You can use 
the Next Frame and Previous Frame buttons 
under the preview monitor to find the exact 
frame that you want. 

 

3. In the Home tab click Snapshot. 

 

4. Browse for a location where to save the picture. 
 

5. Type a name for the picture file, and then click 
Save. 
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CHANGING ASPECT RATIO 

 You can create videos with two types of aspect 
ratios: widescreen (16:9) and standard (4:3) 
 

 You have to decide what is going to be the likely 
source for watching the video (e.g. widescreen 
video is good for certain laptops, iPods, and 
such.) 
 

 Follow these steps: 
 

1. Click Project and then click Properties. 

 

2. Select Widescreen or Standard. 
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PRACTICE #6 

1. Change your project to widescreen. 
 

2. Re-save your project. 
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PREVIEW A PROJECT 

 You can preview whole projects or smaller components 
such as audio or video clips, transitions, and effects in 
Windows Movie Maker. 
 

 Periodically previewing a project in the monitor as you 
work on it is useful to see how it looks and sounds and 
to check your editing. 
 

 Or, to ensure that you have imported the content that 
you want to use in your movie or to change individual 
clips, you can view or listen to an individual video or 
audio clip. 
 

 You can also preview video effects and transitions to 
see what they look like before you add them to your 
project. To do this, click an effect or transition in the 
Contents pane, and then click Play under the preview 
monitor. 
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PREVIEW A PROJECT 
 

 Follow these steps: 
 Add one or more clips to the SB/TL, if you 

don’t have them already. 
 

 Click the Play button to start the preview. 

 

 You can use previous frame or next frame 
buttons to slowly move back/forward a frame.  
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SAVING AND PUBLISHING A 

MOVIE 
 When you finish working on a project, you can 

publish the project as a movie. 
 

 A movie is a Windows Media file with a .wmv file 
name extension or an Audio-Video Interleaved 
(AVI) file with an .avi file name extension. 
 

 When you publish a movie in Windows Movie 
Maker, you can share it with others in a number of 
ways such as (to name a few): 

 through your computer 

 recordable DVD 

 attachment in an e-mail message 

 Windows phone. 
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SAVING AND PUBLISHING A 

MOVIE IN COMPUTER 
1. In the Home tab, click Save Movie button in the Finish 

Movie section. 
 

2. Select the recipient for your video (e.g. computer, DVD, 
etc.) 
 

3. In the File name box, type a name for your movie. 
 

4. In the box below, choose where you want to save your 
movie once it's published. 
 

5. Click Save.  The movie file will be generated and it may 
take several seconds or minutes. 
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PRACTICE #8 
 You have been asked to produce a movie 

related to the Amazon rainforest for one of your 

school classes.  You have several resource 

files at your disposal. 
 

1. Go to the class wiki and download the Amazon 

videos to your disk.  Make sure to watch them once.  

The video files are: 
 Amazon animals 

 Amazon plants 

 Amazon explorers 

2. Download the audio file Amazon audio master.mp3 

into your disk.  Make sure to listen to the file once. 
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PRACTICE #8 
 

3. Synchronize the amazon animals’ video clip 

with the amazon audio master.  Do the 

necessary editing.  
 

4. Incorporate  the plants and explorers video 

creatively in your production. 

5. Produce the video as a wmv file called 

AmazonSchoolMovie.wmv 
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